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MTV Networks Quizilla (Social networking) - http://www.quizilla.com
IHOP (Restaurant chain) - http://www.ihop.com

Harvard University (Educational) - http://gsas.harvard.edu

The Green Maven (Eco-resources) - http://www.greenmaven.com
Outdoor Photographer (Magazine) - http://www.outdoorphotographer.com
PlayShakespeare.com (Cultural) - http://www.playshakespeare.com
Senso Interiors (Furniture design) - http://www.sensointeriors.co.za

Ooo0Oo0oogooogd

8 vozitafictor g ————

File Edit View History Bookmarks Tools Help
- c ¢y | || | http://gsas.harvard.edu/
2 Most Visited P Getting Started Latest Headlines

Facebook | Partha Sarathi Kar T1( > | || http://gsas.harvard.edu/ X "% SEC | SYLHET ENGINEERING COLLE... x<

Jo o o P .
The GRADUATE SCHOOL of ARTS AND SCIENCES Harvard University

contact us
apply

important dates
search

forms

Resources For:
Current Students

Prospective Students
Faculty
Alumni
Visitors

GSAS News

January@GSAS Kicks Off This New Student-Led January It's Course Evaluation Time Interested in Becoming a

Week Courses Students, course evaluations House Tutor?

View the full schedule of Check out the new student-led | are open through January 10. GSAS students, gain valuable

January seminars, workshops, January@GSAS course Your voice counts: Evaluate experience and play a

and gatherings here! offerings, sponsored by the here. meaningful role in the life of
Graduate Student Council, Harvard College: Apply here to
here. become a House Tutor in

2010-2011.
More News...

Home | Harvard Home | FAS Home | Sitemap | Trademark Notice
Copyright @ 1999-2010 by The President and Fellovs of Harvard College
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*IReeTel fqeele ¢ eiyfe fefamres-  www.sust.edu
Freet 2fefaifae Fee-  www.sec.ac.bd

T ST (o157 www.bangladesh.gov.bd
JIFTTA* STATCTN (W5 6F- www.bdosn.org
JRENCT FIFIER @R 6T ARG B

I ) I

(& SEC| SYLHET ENGINEERING
File Edit View History Bookmarks Tools Help

s C &Y (L] | nttp//www.sec.acbd/ SINE

£ Most Visited Getting Started Latest Headlines

Facebook | Partha Sarathi Kar 7r{ % | || SEC|SYLHET ENGINEERING COLL... X | [E] Facebook | Partha Sarathi Kar TR( X

SYLHET eNGINEERING COLLECE =3
@ SHAHIALAL UNIVERSITY OF SCIENCE & TECHNOLOGY

Home About SEC Admission Academic Campus Life Library News & Events Dormitories Contact us

Side Menu &% Admission Test
Home Overview 2009-10
pa .ﬁ.nout SEC i Sylhet Engineering College (SEC), established in the year 2007 under the School of Circular of undergraduate

e % Applied Science and Technology, Shahjalal University of Science and Technology is best admission test for B.Sc
e of its kind with a motto to produce the best in class engineers for the 21st century in Engineering will be published
= Academic Bangladesh. There are five universities of Engineering and Technology and some private here soon. Stay tuned

universities in the country for providing engineering education at B.Sc level which is not
sufficient to meetthe requirement of today's fast paced engineering sector of Bangladesh.
As a divisional city of Bangladesh, Sylhet had no engineering institute. So the Government
= News & Events of Peoples Republic of B 1 has Sylhet Eng ing College with a [7] Notice Board
vision to expand the engineering education of Bangladesh as an engineering faculty

= Campus Life

= Library

Dormitories Cyber Battle 2010
2 section of Shahjalal University of Science and Technology. i
= Contactus The Department of Computer
With a state-of-the-art faciliies and a Science and Engineering is

going to organize the biggest
computer gaming event of
Sylhet Cyber Battle 2010 at

marvelous landscape of campus, Sylhet
Engineering College has become an

< Mail engineering educational hub  of
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About joomia »

Cetting Started »

Create and Share »

Contribute to Joomla »

Core Features »

Download Joomla »

Technical Requirements »

Try Online Demo »

About the Joomla Project »

Mission, Vision &
Values »

Code of Conduct »

Leadership Team »

Project Teams »

Honor Roll »

Partners »

Conditional Use Logos »

Sponsorships »

Download Joomla!

Enter your email address to receive automatic security updates:

Download mia! 1.5.x

LANGUAGE VERSION DOWNLOAD

English (UK) 1.5.15 Full Package 7P
English (UK) 15.14t0 15.15 Upgrade Package 2P

Download other Joomla 1.5.x packages »

Need help installing Joomla? Download the Installation Manual (PDF), the Quick Start Guide (PDF), or visit our Installation
Forum.

Need help upgrading Joomla 1.5? Click here to view step-by-step instructions or here to see the steps to migrate from Joomla
1.0x

Need Joomla in your language? Find a language pack or localized version.
Looking for ways to extend and customize Joomla? Visit the Joomla Extensions Directory.

Want the latest changes from the JoomlaCode SVN? Find them here.



http://www.joomla.org/download.html
http://www.apachefriends.org/en/xampp-windows.html

MySql
FileZilla
Mercury

XAMPP Contrel Panel Version 2.4 (30. October,
Windows €.1 Build 7600 Platform 2

Current Directory: D:\joomla\xampp

Status Check OK

xampp-control
12/21/2007 8:01 AM || ]
148 KB

Edit View Favorites Tools Help

°Back > @ @ @I{Os.earch %Favo’ites &4 B' & B -

flocalhost/xampp/

.
E XAMPP for WINdoWs  sses s simsmsnasas

Portugués (Brasil) ' B
XAMPP

Welcome to XAMPP for Windows Version 1.6.0 !

Congratulations:
You successfully installed XAMPP on this system!

MNow you can start using Apache and Co. Firstly you should try »Status« on the left navigation to make sure everything works fine.
For OpenSSL support please use the test certificate with https://127.0.0.1 or https:/flocalhost
And very important! Big thanks for help and support to Carsten, Nemesis, KriS, Boppy, Pc-Dummy and all other friends of XAMPP!

Good luck, Kay Vogelgesang + Kai 'Oswald' Seidler



http://localhost/

e Joomla upload in local server:

QU TS F9I9 &) GNAIF UNZIP FIZAM copy 6 AT xampp € htdocs folder €3 (8 paste
TP 191 S @ FICT database ¢ofd 939 @12 TN joomla F2#0 rename FF |

Example: @5 2907 @ FIT A=K ->Joomla_1.5.10-....

#/fF rename FC3= Joomla_1.5.10-.... ->pskpartha

» Computer » partha(D:) » joomla » psk...joom » psk »

Share with » Bumn New folder

Organize v Include in library »

Favorites

& Downloads : . > l] ..l >

Recent Places

Joomla_1.59-Sta ﬁ?:‘;li'”lg:i?
y Libraries ble-: _Package e -
*| Documents

o) Music LLEY2Z J_ };:‘

= Pictures

B videos
& Computer

€ Network

e Database create:

» Computer » partha (D:) » jooml

Organize v Include in library « Share with
{ Favorites
Bl Desktop
& Downloads .~l
Recent Places
pskpartha
y Libraries
| Documents
o Music renaine
&= Pictures

B videos
1% Computer

€l Network

TR & database (of7F &+5 xampp @@ phpMyadmin tool 6 95<%9 99 |

& ] http:/flocalhostiphpmyadming
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©iK?[ Tool ¥¥ phpMyadmin @ click ¥ 1949 S19f§ Joomla’r folder {6 @ 915 Mtx rename
AR (12 1% 102 create @ click $F4 |

2 localhost / localhost | phpMyAdmin 2.9.2 - Microsoft Internet Explorer

Fila ES View FavorRes Tools Heb

"‘_ :‘ Search Favorkes <) - &8 u :‘s

. 7/

o abhost fphpmy adenind

localhost phpMyAdmin - 2

er version: 5.0.33 » MySQL client version: 5.0.

sion: 10 » Used PHP extensions: mys
lhost via TCP/IP FLanguage @
» User: root@localhost English

charset: UTF-8 Unicode (utf8) &#Theme / Style: | Darkbluefors
inection collation

_.‘ ode_ci v @

[2l[=](=](=]

Database

* Font size: 100% v

Please select a # @phpMyAdr
database ©Create new database ® S e
| " @Officia :
" » [Chang
Collation v |__Create |
PShow MySQL runtime Information
Bsh system variables @
RaPro
Ect 5 lati
SISt es
PF @
&Pr
48]
(oS
pl
|

File Edit View History Bookmarks Tools Help
@ v c 2 | s | http://localhost/phpmyadmin/ b [(:I‘

£ Most Visited P Getting Started 5 Latest Headlines

ijijf;}fjfijJ'J &3 Server: localhost » (1 Database: pskpartha
@@I Structure 72 SQL Search [GQuery @#iExport [ilmport cSDesigner %ZOperations g3 Privileges [¥ Drop
fa} || -
«/ Database pskpartha has been created
Database CREATE DATABASE ‘pskpartha®
pskpartha A
pskpartha (0)

No tables found in database. No tables found in database

r “.g Create new table on database pskpartha

Name: Number of fields:

Example: ST pskpartha 104 rename FCReT | ©12 @< database 7% pskpartha o149 |
IR @2 (43S @ Al database SR T 5% 33 W #nf | Privileges @ click S (747 @
QT ST REEICEE ¥ A root HIRE TR |
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Phpj,?__‘}; drnln &3 Server: localhost » (& Database: pskpartha

@@] o Structure R SQL  Search [EiQuery AhExport Jlmport eEDesigner 48Operations &3 Privileges [ Drop
& Users having access to "pskpartha”
Database User Host Type  Privileges  Grant Action
pskpartha Y oot 127.0041 global ALL pRIvIIZGES Yes Y

root localhost global ALL PRIVILEGES Yes &

pskpartha (0)

No tables found in database.

e Joomla Installation:

@33 iR et installation ef@fs (= | sier web browser «
http://localhost/pskpartha feta enter & 192its pskpartha wibiee a3 7w |

B somist Web Instailer s MiEzE Frec

File Edit View History Boockmarks Tools Help
@ - 7=y | B8  http://localhost/pskpartha/

2, Most Visited ’ Getting Started [ Latest Headlines

Step:1
Choose Language:

English fr=13 w2 next ext B (5 T |

B Joomla! Web InstalleF= Mgz ey
File Edit View History Bookmarks Tools Help
@ - o httpi//localhost/pskparthalinstallation/index php % | |[Gl-| Google p

2 Most Visited P Getting Started 3. Latest Headlines

! Joomlal™ Installation

Version 1.5

Steps Choose Language Hext
1:Language
Select Language

2: Pre-installation Check Please select the language to use during the Joomla! installation steps:

ar-DZ - Arabic - Algeria -
3:License be-BY - Benapyckas-be-BY

bg-BG - Bulgarian (Benrapcku)

. bn-BD - BengaliBangladesh)

4:Daiatn e ca-ES - Catalan

cs-CZ - Cesky (Czech)
5:FTP Configuration da-DK - Danish(DK) L

de-DE - Deutsch (DE) 3
6 : Configuration el-GR - Greek

GB - English ited Kingdom)
Sl LRl .

7 :Finish

eo-XX - Esperanto

es-ES - Spanish (Espafiol internacional)
et-EE - Estonian - et

eu-ES - Basque (Euskara estandarra)
fa-IR - Persian(ows,L)

fi-FI - Finnish (Suomi)

fr-FR - French (Fr)

guIN - 2221l (Gujarati)

hr-HR - Croatian (HR)

hu-HU - Hungarian (Magyar)

is-IS - [slenska (Iceland)

it-IT - Italian (italy)

ja-JP - Japanese(JP)

lo-LA - Lao (was9990)

ILT - Lithuanian >

Joomla! is free software released under the GNU/GPL v2.0 License.

17



http://localhost/pskpartha

o Step:2
Pre-installation Check:

Qe el install F90e @ REete vaee ¢ MINIees $iF 9ot Sifes Stz 1991ty configure
0 g 8 |

Next |

next ~ 5 fFF I

File Edit View History Bookmarks Tools Help
@ - c 4 (@ nttp/localhost/pskparthayinstallation/indexphp - (G| Google Pl Y

2! Most Visited Getting Started 3\, Latest Headlines

loormlal” Installation

Steps Pre-installation Check checkagain ()| () Previus | ext

1:Language
Pre-installation check for Joomla! 1.5.10 Production/Stable [ Wohmamni ] 27-March-2009 23:00 GMT:

2: Pre-installation Check

PHP Version >=4.3.10 Yes
3:License -Zlb Compression Support Yes
- XML Support Yes
4: Database o Nes
MB Language is Default Yes
5+ FTP Configura B String Overload Off Yes
El configuration php Wrtzble Yes
6 : Configuration
Recommended Settings:
7:Finish
the recommended
Directive Recommended Actual
stil operate even if you Safe Mode: off off
Display Errors: off On
File Uploads: On on
Magic Quotes Runtime: off off
Register Globals: off off
Output Buffering: off off
Session Auto Start: off off

Joomla! is free software released under the GNU/GPL v2.0 License.

e Step:3

License
e «ft @6 fF Ao, O 78 W7 GNU GENERAL PUBLIC LICENSE #t3 fte #iitzs

Next

| |l<te configure 917 5% (73 | next ~ 315 e e

18



http://localhost/pskpartha/installation/gpl.html#TOC1

¥ Joormlal” Instaltation

Steps License
s GNU General Public Licens:

2:Pre-installation Check
Table of Contents

3:License * GNU GENERAL PUBLIC LICENSE
© Preamble

4> Datbnss) © TERIS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODFICATION
: © How to Apply These Terms to Your New Programs

5:FTP Configuration
GNU GENERAL PUBLIC LICENSE

6: Configuration Version 2, June 1991

i Copyright (C) 1323, 1991 Fres Softwsre Foundstion, Inc.
7:Finish $9 Temple Place - Suite 330, Boston, MA 02111-1307, USA

Everyone is permitted to copy and distribute verbatim copies
©of this license document, but changing it is mot allowed.

Preamble

‘The licenses for most software are designed to take away your freedom to share and change & By contrast, the GNU General Public License is intended to guarantee your freedom to share and
change free software—to make sure the software is free for al ts users. This General Publc License applies to most of the Free Software Foundation's software and to any other program whose
‘authors commit to using . (Some other Free Software Foundation software is covered by the GNU Library General Pubiic License instead.) You can apply i to your programs, too.

When we speak of free software, we are referring to freedom, not price. Our General Pubiic Licenses are designed to make sure that you have the freedomto distrbute copies of free software
(and charge for this service if you wish), that you receive source code or can get if you want &, that you can change the software or use pieces of it in new free programs; and that you know you
‘can do these things.

To protect your rights, we need to make restrictions that forbid anyone to deny you these rights or to ask you to surrender the rights. These restrictions translate to certain responsibiies for you if
You distribute copies of the software, or f you modity it

For example, if you distrbute copies of such a program, whether gratis or for a fee, you must give the recipients allthe rights that you have. You must make sure that they, too, receive or can get the
‘source code. And you must show them these terms so they know thei rights.

We protect your rights with two steps: (1) copyright the software, and (2) offer you this license which gives you legal permission to copy, distribute and/or modify the software.
Also, for each author's protection and ours, we want to make certain that everyone understands that there is no warranty for this free software. If the software is modified by someone else and

Joomla! is free software released under the GNU/GPL v2.0 License.

Basic Settings

This is probably MySQL

localhost | This is usually localkhost or 3 host name provided by the hosting provider.

Username 75 can be the default MySQL username root. 3 username provided by your hosting
root provider, or one that you areated in setting up your database server.

Password Using a password for the MySQL account is mandatory for site security. This is the
same password used to access your database. This may be predefined by your
hosiing provider.

Database Name Some hosting providers aflow only 3 spedfic database name per account. If this is the

case with your setup, use the table prefix option in the Advanced Settings section
below to differentiate more than one Joomia! site.
> Advanced Settings




! Joomlal

7Steps

1:Language

2: Pre-installation Check
3:License

4: Database

5: FTP Configuration

6 : Configuration

7 :Finish

Installation

‘ Database Configuration

Setting up Joomla! to run on your server involves four easy steps.

The first step is database configuration. Choose your preferred settings:

Basic Settings

Select the type of database from the drop down list. This wil generally be MySQL.

Enter the hostname of the database server Joomla! will be installed on. This may not
ly be the same as your Web server so check with your hosting provider if

‘you are not sure.

Enter the MySQL username, password and database name you wish to use with
Joomla!. These must already exist for the database you are going to use.

Advanced Settings
Select how to handle existing tables from a previous installation.
Enter a table prefix to be used for this Joomla! installation.

" Settings

DatsbaseType =

mysql This is probably MySQL

localhost This is usually localhost or a host name provided by the hosting provider.

usemame 7 can be the default MySQL username root; ausemane proded by your hosig
root provider, or one that you created in setting up your database ser

Using a password for the MySQL account is mandatory for site seaurity. This is the
same password used to access your database. This may be predefined by your
‘hosting provider.

Some hosting providers alow only & specific database name per account. IFthis s the
case with your setup, use the table prefix option in the Advanced Settings section
below to differentiate more than one Joomla! site.

[» Advanced Settings

Joomla! is free software released under the GNU/GPL v2.0 License.

Basic Settings

@ ves
@ No

FTP User

FTP Password

FTP Root Path




Joormial™ Installation

Steps ' Main Configuration
1: Language

2: Pre-installation Check

Enter the name of your Joomla! site,
3:license

4:Database

Contirm the Admin E-mall and Password.
5 : FTP Configuration -

Enter your e-mail address. This wil be the e-mail address of the Web site Super
6: Configuration Administrator.
Enter a new password and then confirm itin the appropriate fieids. Along with the
ame admin, this wil be you vl se t2login ta the
7 : Finish o
T Yo e et Y e v e sarton: our asrert etings vl b
automatically migrated.
Load 'I"IP‘! data, restore or migrate back.q-up Bﬂ’l!.ﬂ'

Importants: Itis strongly recommended that new Joomlal users install the default
sample data. To do this, select the option and’lick on the button beforemoving to
the next stage.

Bafore -vmnm installation, you can populate the site database with data. There
e thr s to do this:

L Default sample data can be neerted. To do thi, select the frst option and
tall Sample Data button.

28.A J00mlal 1.5.x compatible SQU script file can be uploaded from &
executed on the site. Yhsmldb:ﬁ:r nstaling localsed sample data

or res m.mm 1.x badup, The have the correct table

prefixes, be in UTF-8 encoding and cmvvywlmmmu 1.5.x database schema.

2b. Migrate content from D'!m versions of Selecting the Load
Migration Script option enables support for the migration nfnlder)oomln!l x
vumamwu-mwmus site, The require

performed on-the.fy o e g ton kPt e ot be crevad on o cider e BY

component.
about the component and the migration procedure, please
Joomlal 1.5 Migration Guide.
a
Mnu-nmlsnlﬁw-nm/fdd« ename it migrate. =ql and then tick the T

3. Clean InstaNstion: 1 you wieh (5 pafform o lean nstalaton; enter (e iy
choose a password, Then proceed to the final step by

@ previous | next @ |

_pskpartha

©  Install Default Sample Data

partha@sec.ac.bd

Enacaling sdcle dote & errongly recommenced for baghnes. Tim il hetel
sample content that & included in the Joomls! installation package.

The migration script needs to be created on the old site by the com_migrator
200/ to conform, Enter the table prefix of the okd site and enter the
used in old site (ISO setting in language e or a5 seen in browser info/encoding

Joomia? 1.8 migration SQU scripts need to be Joomla 1..5.x compatibie and shoukd
have the appropriate table prefix.

‘Your server's maximum file upload size is 64.00M8. .

—
—

[’Imanumdymnm.mmmm-m«(- . via
ﬂww--m1 1.0 migration script.

Upload and Execute

Instaling sample data is strongly recommended for beginners. This wil
Install Default Sample Data sample content that is induded in the Joomia! installation padkage.

@) Load Migration Script The migration script needs to be aeated on the old site by the com m3|
foof to conform. Enter the table prefix of the old site and enter the
MnMskLEOseManlage or as seern in browser info,




PLEASE REMEMBER TO COMPLETELY
REMOVE THE INSTALLATION DIRECTORY.
You will not be able to proceed beyond this point until the installation directory
has been removed. This is a security feature of Joomlal.

Administration Login Details

Username: admin

Joomla! in your own language?
Visit the Joomla! Help Site for more information and downloads.

3 J\Jl

cache components images

configuration



http://localhost/pskpartha

& Welcome to the Frontpage - Mozilla Firefox N N

File

Edit View History Bookmarks

®

£ Most Visited ® Getting Started

Tools Help
» C o

http://localhost/pskpartha/

Latest Headlines

N E Ioomlc I and more. Site administr:
About Joomla!
Home

Latest News

Suidelines

Home

Joomla! Overview
Joomia! License
More about Joomla!
FAQ

The News

Web Links

News Feeds
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Kar ,studying in the Department of Computer Science & Engineering in Sylhet Engineering College.
My E-mail Address: 1. partha@sec.ac.hd

2. partha@gamer.com.bd
My Yahoo MSN id: pskpartha
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 Introduction
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My name is Partha Sarathi Kar ,studying in the Department of Computer Science &
Engineering in Sylhet Engineering College.

Who's Online
We have 1 guest online
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Install from Directory
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- Module: [Edit]

Module Type:
Title:

Show Title:
Enabled:
Position:
Order:

Access Level:

This module allows you to add any htmljavascript (within the document's body tag)
to a module. t can be used to add affiliate code, copy and paste codes, google
adsense eic. You can copy the module using mambo’s module copy feature, and
create many differnt html content.

Menu Assignment

Menus: @ a4y ) none ) Select Menu kemis) from the List
Menu Selection:
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<link rel="shortcut icon" type="image/x-icon" href="www.tinypic.com/pskpartha.gif" />

SFCRETIZS (7 o1 (B 208 SR favicon 6 (FIR ST’ ©F f#1eF 1 Google @ AT ATeT SIRPSTE 7125
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Extensions > Template Manager > SII%«1% (G125 {6 37018 $5% > Edit > Edit html

Joormlal™ pskpartha

Version 1

[ Preview 0 M1 O Logout

I Template HTML Editor e v © O

Save  Apply  Cancel  Help
Ciapache2tr pskparthaitempl _milkyway\i php
<?phR -
* @copyright Copyright 2005 - 2005 Open Source Matters. 211 rights reserved
* @license GNT. NSE.php
* Jogmls! is fres software m=y have been modified pursusnt E
* to the GNU General Public License, and as distributed it includes or
- orks licensed under the GNU General Fublic License or
- open source software licenses
* See COPYRIGHT.phy for copyright notices and details
// no direct access
defined{ '_JSXEC' ) or diel 'Restricted aceess’ );
25
<!DGGTYEE Bitml PUBLI DIR X 1.0 Transitio: /¥html1/DTD/xhtmll-transitional dtd">
<Bfml xmlns="http://www. w3 /1338 xhtml” wml:lsng="<?php echo $this->language; 2>" lang="<?ghp echo Sthis->language; ?>" >
<head>
<jdeg:include type="head"” />
<link rel="ggvleshest" "<?php echo $this->hageurl ?>/templates/system/ggs/system.gss” type="text/gsg" />
<link rel="ggvleshest" "<?php echo $this->hagenrl ?>/templates/system/gss/general.gss™ "rext/csg" />
<link rel="sgylsshest" "<?php eche $this—>baseurl ?>/vemplates/rhuk milkywey/sss/vemplate.css” type="text/csg" />
<link rel="sgylsshest" "<?php echo $this—>baseurl ?>/vemplates/rhuk milkywsy/sss/<?pbp eche $this—>parsme->get!'solesVsziation'); ?>.css" type="text/gss" />
<link rel="srylsshest" hzsi="<?php echo $this—>baseurl ?>/cemplstes/zhuk milkiwsy/css/<?php eche $this—>pazsms->gec('backaroundissisnion'!: ?>_bg.css" type="text/gsg" />
<l--[if lze IE 61>

$this->bagenrl ?>/templates/<?php echo sthis->template ?>/gss/isonly.css” rel="spylesheer” type="text/gsg" />
this->directien = "ggl') : 2>
link href="<?php echo $this->baseurl ?>/cemplates/zhuk milkywsy/css/template rrl.css" rel="smyleshssg"” type="text/gss" />
<?pbp sndifi 7>
ass="color_<?php echo $this->parsms->get!’'colezVazistion'); 27 bg_<?php echo $this->pazams->get('kackaroundiazission’); ? width_<?php echo
sddEhStyle 1 277> =

"o

" alimn="rentar">

Joomia! is Free Software released under the GNU/GPL License.

SR OTS FF AT FTE T (T4 | Bl hitp://bdosn.org)
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2t% G73 Rename (3 .htaccess @ T I |

php. Ini FZABCS FEITE ARRET ST FIAGTEAT T 5 I T |

register_globals = off (or =0)
allow_url_fopen = off
define('RG_EMULATION', 0 )
safe_mode

allow_url_fopen
allow_url_include

SR ST 125 A THICEeS W f2f 3 jos_ FING o1y @ TN (@N- psk_)#fG@es T 1594
AT A FF9E configuration.php 98 var

$dbprefix = jos_'; 2SS FCS AR 1 |

2] FACE SAPNE configuration.php FIRAD FFCAE AATS AT | AKTFANE THITIS G T A
COICIZA TR AR e e AR 1 |

FoIF T GeTH ey A A FCAMTTRTE A5 7w 1 Pifseae I S @esta Sioites
FEA 1 T W AT A AT e T P WA AR R GHOE CEER @ A
TIGACAIG Pl IR ROETH (A (AT IR e |

http://extensions.joomla.org

TR Farerel 9 wike [@ifae siees 5126 Joomla Web Security! ST G5! 92 SI1TR U56T THIRHG
(ACF TICCC TS A |
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http://joomlacode.org/gf/download /frsrelease/9141/34038/bn-BD admin 1.5.8.zi

32 [fHs TeAETIePS & 3110 QHGIE FPe | (SOt i (@FIT1F @ index.html] T @6 FIZ
AT | S22 7125 «F /htdocs/administrator/language FITFITH T | SRR CTAITT (SOCEH
9% IR 8 index.html T2 T TSI FI2CE Replace T | SRR S2ATEG 47 2 (N ST
253 ST “ftcad Extensions>Language Manager € 1 | SR W64 T© (TS AR |

e Language Manager

()

Defautt  Help

Site Administrator

Language Name Default Version Date Author Author E-mail

«31d Bangla PICAIgs S0 Default @ {5 354 |

SRR SR B0 JACE 6 (MY FI(BY A1 (ARITR QIR JET LD FI TN S*(78 SR
SEFATGTAT SERCHIC @ o |

wEIE=E: 2010 pskpartha. 79T matFe
FEE A% & FSEaANE GNUIGPL 37 SiEiE. TRA...
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Find functions quickly by typing here.

’ Last login from Neone Recorded

Monthly Bandwidth 0 / 2000 MB
Transfer |

‘\D&skSpaeeUsage IO

expand stats

HELF  LOGOUT

Ac_cglerated

Preferences

"BEEE

Video Change Update Change RVSkin
Tutorials  Password Contact Style Theme
Info

Getting
Started
Wizard

2 &

Webmail BoxTrapper Spam

Assassin™

A 4 X

Mailing User Level  Account Email
Lists Filtering Level Delivery
Filtering Route

Default
Responders Address

¢ =5 A2

Import Email MX Entry
Addresses/ Authentication
Forwarders

= 5

Backup File

Legacy
Wizard

Manager File
Manager

Web Disk Disk FTP
Space Accounts
Usage
FTP

Session
Control

e

Latest
Visitors

&

Choose
Log
Programs

B s én o/

Bandwidth Webalizer Webalizer Raw
Access
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Error log
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e
D ) gz Export
o2 A AR ETFE MOR @ P OISt A |
— —y
| Al localhost / localhost / pskpartha / | php... | + |
€ - @ M | AL http//localhost/phprayadmin/ T "l' Google
@ localhost » 1 pskpartha
B Structure 2 sqL  [Search [@Query EExport  Timport %E Operations g3 Privileges [ Drop
PhpiizAdmin Table Action Recordsy  Type Collation Size Overhead
A gl g jos_banner i5 ¥ @ X g MyISAM  utf8_general_ci 5.3KB -
jos_bannerclient ig F M X 1 MylSAM  utf8_general ci 21KB =
Database - ; ==
pskpartha (36) |z| jos_bannertrack ] x 0 MylSAM  utfd_general_ci 1.0 KB -
jos_categories ig @M X 21 MyISAM  utf8_general_ci 6.9KB -
g !cz‘b:;;:;dient jos_components i5 @ X 32 MyISAM  utf3_general_ci 72KB -
g :tr;?crrti:-:k jos_contact_details i # @ X 1 MylSAM utf8_general_ci 3.6KB -
E e jos_content ig | X 43 MyISAM  utf3_general ci 71.6 KB -
=] :cntent_ fnm noménnt frantnamn A & AR S B W 7 RMACARA D mnmnen (P, LEN=]
Ehp

phpMyAdmin

2. TRUF S G @ T BT @ 1 0o S | R TBTESS Import
T |

MLy
MySOQLE
Catabases

9., smdice T GIBICTer ZTETI (N e TGS Col e | 9T Lo

BTEF (12 G 2IPTETTC K TGS 8 FARFANEH (Configuration.php)d SITEs F+ | TIBITAS
Import IR ST QS FE FACT OF A | QI A [FOIF SRIERE B S#TEe T4 07 |
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. MySQL Databases

MySQL Databases allow yvou to store lots of information in an easy to access manner. The databases themselves are not

easily read by humans. MySQL databases are reqguired by many web applications including some bulletin boards, content
management systems, and others, To use & database, you'll need to create it. Only My50QL Users (different than mail or

other users) that have privileges to access a database can read from or write to that database.

&l 'l'_'lump to MySQL Users

Create New Database

Mew Database: ssaradio_

Current Databases

There are no databases associated with vour account.

MySQL Users

Add New User TIump to MySQL Databases

Username:

Note: seven characters max

Password:

Password (Again):

Strenath (why): —
Create User |

Current Users

There are no users associated with yvour account.

File
Manager




File Manager settings Search
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New File New Copy MoveFile Uplead Download Delete Rename Edit Code HTML  Change View Extract Compress
Folder Editor Editer Permissions

B [public_html Lﬂ Home 7 Up One Level 48 Back = Farward 5 Reload E Select all . Unselect all

%= Collapse all
=] (a {/home/ssaradio)

cgi-bin

.htaccess

“r Fawvorites
|8 Downloads
=l Recent Places

il Libraries | images 9,/20,/2010 7:22 PM File folder

Documents 9/20/2010 7:22 P File folder
9/20/2010 8:47 PM File folder

/20,2010 7:22 PM File folder
9/20/2010 7:22 PM File folder
% Computer
& kar (C) i 9,/20,2010 7:22 PR File folder
= Local Disk (D:) 9/17,/2010 2:50 PR File folder
w partha (E:) | templates 9/20/2010 7:22 PM File f
o sarathi ()
. xmirpc 9/20/2010 7:22 Ph File folder
€ MNetwork |5 CHAMNGELOG.php 3/28/2009 9:33 AM PHP File 87 KB
|| cenfiguration.php-dist 3/28/2000 9:34 AN PHP-DIST File 4 KB
=] COPYRIGHT.php 3/28/2009 9:34 Al PHP File 2 KB
|m| CREDITS.php 3/28/2009 9:34 AM PHP File 14 KB
|_| htaccess.htaccess 3/28/2000 9:34 AN HTACCESS Fi 2 KB
=] index.php 3/28/2009 9:34 Al PHP File 2 KB

o] INSTALL.php 3/28/2000 9:24 AN PHP File 5 KB

@] LICEMSE.php 3/28/2009 9:35 AM PHP File
|m| LICEMSES.php 3/28/2009 9:35 Al PHP File
3/28/2009 9:36 AM Text Document




TR

I3 fiodd JWAAl ST JANAE SMAT], W DA PR Sl (AR (ST DA 2143 [ 28 fag
RS A JAMAME Sl A I FAT NS (I8 A A |

e o A @S

60




T (STSAPIAA S5 - JREBISIS! - S Gy

IS T G TR ST (CISARMR M4f @ Aeenfoe w1 «aft frea asfies @we 4@ 2wz
SRRAIRE COf TN A, S T el R0 AT FITIens SCae 241 T | & HeT [Feniif™i
LB AR I TSN I | ST SYAG ST (= &y 7=y G (6 Zrepifie cAiie 2o
GRS | Q3 AT GRS A12C63 [T 617 T SCeTsa 1 & |

e Afiffe:

e (Joomla) T2 @FG Content Management System I CMS i TWta SHIITT F KF074
STRIITIED, (I AR (IR A GH AT Tl 2GI2 Cofi T 7R | =& DR IR e Eovewe
e AR T @RI Tl GRS QB =Gl STHIAILH Cofad AT ST ARTS FERCR |
FAToIf ST GG ST TG ST A SR STHAIRT (AT AL Hee® 1 AR | AR HA1Z06F
o1 2052 - www.joomla.org | e PHP tﬂ?‘{MySQLmZ@@WWI @I?WWHW
AT FTHICE @11 ST SR 250e S3 flre 2 |

el e eifefaere Sk SraeeTIRD Coftl 209, AR W04y SerAtaiely 20 -
TG STAIAIRG T (AT

FCAIRD TRICIE UIR 9FITAD

SRS e, AFworE «3e [fey waea et
- ARG I eI SIS
EEEACIREICH B

TR € F7 TR &7 SN2
ELICEEERUE RS PR RCE R G EHI PO
ST S co1ioT

fqfeq FrrafedieT ew<e3s

FfeTe At Al @wesEs

RETHI 12D AAfRfoS:

! AT STARPTIRE O I AT SIETIZC SITFACS SN, SR & GHFI @5 [yt Sres et
ARG 200 - GRS | ARG S 205z - www.joomlancers.com | & ARGHBTS o 3¢ (A
>@o 5 2TeTs AT TR | BT 9 2RISR S0 FEIF IR AN FIEG AR 2R q FSIF Gl ey =T=
(TSR @IESE FCRACR | A ARG F=i R 2f S ateda 0% 9L (FeReE ey F0e 7 |
AIEUBH (I (AT (T 1 AR FACO R T | QFGep1€iEe GagFiat 7o S ¢ b 7 Face
AR, AVACE GFSHCENT (@FE T S ¢o 5 [T F909 21t 1 ¢ @FIK S A &S T 9o TTE I
ARG FICO T | O ¢ TARK M GFIREE & G117 (IFIK 8T IR | ARBCS @G« 419 &
@I o Mo =7 71, Toiag @ISEg== FIF #I7 ATOIF eI { G (@17 20« 31 2 |

61



http://www.gournadi.com/news/tech/1227-2010-07-29-11-34-04
http://www.joomla.org/
http://www.joomlancers.com/

G @SN Fier F:
AT ARG A7 T4l FrEmifane MR 102 FIe F0F —

») AT IR/ FIEIT 96 TG 2ATHE (7B IR |
R) fEFsr=Ta 6% aters e 1 S 36|
©) SITAT T4F (ATF AR AFSHFCE W15® FC |

8) W7 AR AEHA Escrow GIFIGTD ATSFA T4 BIFT &l AT, Al FT& I{g TR A7 =i
BTl ARIR szl emis e |

@) FTIISTR OIF 16 S S G2 T 2419 79 T IR 2N 3|

b) ATEE ATTFOICT T =0 AT FIE6 &89 T G AR Escrow (TS B! [Fiies Fecs
BT G |

62




LTSI AFIACON:

12f5c® Joomla @8 Drupal, osCommerce, Wordpress @3 Se) AT FIE ANSHT T | AR00F AT
IR AL ATTBSTT &AW 1 73 | GF5 ATENE IR O bifRw St Rfen «@es (Rf*8y @t Fce
AT | CIMBIGT 0% -

« Featured Project: 1% 430K 2TEE AT ST O TGS OAF N NI 11,
TRpeTIT=ITR 11 ST QAT S0 AR |

Gold Member Project: S4I@ (2% (NFRT G2 G0 TS <G FC A7 |

Sponsored Project: 4 403 2TE3F I S IIGTS QIR O 29I« FACS AN |
Hide Bidding Project: 2 374 T3 QFGeSTRR [RTCK &7 ST (AT A 7 |
Nonpublic Project: Q3 4303 2ATHFYTECE A> SfGTHAR TR (ATF (R A T Q3R SLA@
SRR TR 77 2N DR (T I |

o Private Project: 13 430719 &TSI(3 (ST AN FS FIHIAIR € F40© A |

« Location Project: IR 5 I (71 (AR {EFII™TRRIZ. 0 €0 203 @ 40 AN |

« Urgent Project: 1 KA(<< 23 € S TN 20% © e |

G 2res e F919 A&fs:

IR ARG GYS “MaOTS [E FACO 2 | SR QTGS {0 Srarfs Ty, I R TSy
@ (FC (AT AT | OCF R S0 B ORI CA1o4 IS 2I1ed | [ T A1peere PM Al
AIZTSD FICS SR AL IR AL GFSOIE @A T TR | € T &y 20w
AR @IGET G3R T3 T 0o =R | 9F6 2lters JB1R [ova St fR© F17 4% 21eq I’
TS SR TR o1, 203 T ST TSI I, WS T/ 901, IRNE AN GFPOII
QT = &y PM 2w 02y frcs 27|

o BCSIPTCTR SATTTIR:

GRS 12D (A FoATs “mfors =L Traier 41 A2 | AT 7o g% Paypal - [l SIS
CATH A0 A 1 1 faera “afs 2% MoneyBookers - «@f6 ta o1¢ St 4o g™
FGCF S T BIE e | #I999Ite www.MoneyBookers.com A125 (AGF NEHG %S
sifera7iel f2p fCa S TBTE TS T I BTl FIS FACO 20T | PRl o o8 Wire
Transfer - A T AT AT I QFTSCT B! T SPTCS ARG | 97 &5 475 ST O¢
T |

63




’lﬁ'{"ﬂ'ﬂ';

e M @ T (AR QG2 STRAMR0 (O I ARBI (A8 A (@ AGeH Al o
ol FACT T AHANCS AR WACS A1 GREHHR ARG GAA GBI T QA WP
IE, G0 Taied F41, TG APET o F41, @C AAfRqes 1, SF qFH
SEIARDEE FF T4, IR IR ARTed T4 Toin F& “iheq IR iR gers
TR, fTEi2ae, SEWINFSR - TN G2 SEEnsT 20o A S SFeres &g
TCRGC2 |

64




~STRI-

PARTHA SARATHI KAR

TN I
MANAS KANTI DEY
LECTURE.SEC
—IHI] -

<

SAYEM, JUBAIR, SIDDHARTHA, LIMON

65




